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WIN 1

Exploring the 
Basics of Microsoft 
Windows 10
Investigating the Windows 10 
Operating System

Case | For Pet’s Sake
For Pet’s Sake is a nonpro�t pet-adoption agency in Glencoe, 
Illinois, dedicated to placing adoptable companion animals in 
suitable homes and educating the public about responsible pet 
ownership. The agency depends on its volunteers to help with daily 
operations, pet care, and fundraising. As the volunteer  coordinator 
at For Pet’s Sake, Ashley Cramer recruits, trains, and manages 
 volunteers. Some of her training sessions involve teaching  volunteers 
how to perform their daily tasks using the agency’s computers. 

Ashley recently hired you as her assistant. She has asked you to 
lead the upcoming training sessions on the fundamentals of the 
Microsoft Windows 10 operating system. As you prepare for the 
sessions, she offers to help you identify the topics you should cover 
and the skills you should demonstrate while focusing on the new 
features in Windows 10. 

In this module, you will start Windows 10 and practice some 
 fundamental computer skills. You’ll tour the desktop, start applications, 
and then navigate a computer using File Explorer. Finally, you’ll �nd 
and use help topics and turn off Windows 10. 

OBJECTIVES

Session 1.1
•	Start Windows 10
•	Explore the Start menu
•	Start and close apps
•	Run apps, switch between 

them, and close them
•	Identify and use the controls in 

windows and dialog boxes

Session 1.2
•	Navigate your computer using 

File Explorer 
•	Change the view of the items 

in your computer
•	Get help when you need it
•	Turn off Windows 10

MODULE 1

STARTING DATA FILES

There are no starting Data Files needed for this module.

Note: With the release of Windows 10, Microsoft is taking a new 
approach to software publication called “Windows as a Service.” 
With this approach, Microsoft is constantly providing updates to 
Windows instead of releasing new versions periodically. This means 
that Windows features might change over time, including how they 
look and how you interact with them. The information provided in 
this text was accurate at the time this book was published.
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The Recycle Bin holds 
deleted items until you 
remove them permanently.

The pointer is a small 
object, such as an arrow, 
that moves on the screen
when you move the 
pointing device.

The Start button provides
access to Windows 10
apps, documents, and 
settings.

This box provides access
to Cortana, an electronic
personal assistant.

Windows 10 provides
default taskbar buttons 
you can click to access
popular apps.

An icon is a small picture that
represents an object available 
on your computer.

Session 1.1 Visual Overview:

Copyright 2017 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.  WCN 02-200-203



Module 1 Exploring the Basics of Microsoft Windows 10 | WindowsModule 1 Exploring the Basics of Microsoft Windows 10 | WindowsModule 1 Exploring the Basics of Microsoft Windows 10 | WindowsModule 1 Exploring the Basics of Microsoft Windows 10 | WindowsModule 1 Exploring the Basics of Microsoft Windows 10 | WindowsModule 1 Exploring the Basics of Microsoft Windows 10 | Windows WIN 3 

The taskbar is a strip 
that provides access to
common tools and 
running apps.

The Windows 10 desktop
is your workspace on the 
screen.

The noti�cation area
displays icons for 
services such as an
Internet connection.

This graphic is part of the 
desktop theme, a set of
desktop backgrounds,
accent colors, sounds, 
and screen savers.

The Date/Time control
shows the current date
and time.

Windows 10 Desktop
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Introducing Windows 10
The operating system is software that manages and coordinates activities on the 
computer and helps it perform essential tasks, such as displaying information and 
saving data. (The term software refers to the programs a computer uses to complete 
tasks.) Your computer uses the Microsoft Windows 10 operating system—Windows 10
for short. Windows is the name of the operating system, and 10 identi�es the version 
you are using. 

The most popular features of Windows 10 include its speed, �exibility, and design. 
Windows 10 runs software created speci�cally for Windows 10 and for earlier versions 
of Windows, such as Windows 7 and 8. This type of software is called an application, 
or app for short. You use apps to perform speci�c tasks, such as writing a document or 
exchanging messages with another computer user. You can use more than one app at a 
time and switch seamlessly from one app to another to perform your work ef�ciently. 

Windows 10 is designed to run on computers that use a touchscreen, such as tablets 
and some laptops, and those that use a keyboard and mouse, such as other laptops and 
desktop computers. A touchscreen is a display that lets you touch areas of the screen 
to interact with software. To select a button, for example, you touch the button on the 
tablet display with your �ngertip. However, you are not required to use a touchscreen 
with Windows 10. This book assumes that you are using a computer with a keyboard 
and pointing device, such as a mouse.

Starting Windows 10
Windows 10 starts automatically when you turn on your computer. After completing 
some necessary start-up tasks, Windows 10 displays a lock screen, which includes a 
picture, the date, and the time. You clear the lock screen to display the Welcome screen. 
Depending on how your computer is set up, the Welcome screen might list only your 
user name or it might list all the users for the computer. Before you start working with 
Windows, you might need to click your user name and type a password. A user name is 
a unique name that identi�es you to Windows, and a password is a con�dential series 
of characters that you must enter before you can work with Windows. If you installed 
Windows yourself, you probably created a user name and password as you set up your 
computer. If not, the person who created your account assigned you at least a user name 
and possibly a password. After selecting your user name or entering a password, the 
Windows 10 desktop appears (as shown in the Session 1.1 Visual Overview).

To begin preparing for your training session, Ashley asks you to start Windows 10.

If you have a Microsoft 
account, you can use the 
user name and password 
for that account to sign in 
to Windows 10.

To start Windows 10:
◗ 1. Turn on your computer. After a moment, Windows 10 starts and the lock Turn on your computer. After a moment, Windows 10 starts and the lock T

screen appears.

Trouble? If you are asked to select an operating system, do not take action. 
Windows 10 should start automatically after a designated number of seconds.
If it does not, ask your instructor or technical support person for help. 

◗ 2. Press any key to clear the lock screen and display the Welcome screen.

Trouble? If the Welcome screen does not appear, click the lock screen, hold 
down the mouse button, and then drag the lock screen picture up to display 
the Welcome screen.
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The background area that appears after you sign into Windows 10 is called the desktop
because it provides a workspace for projects and the tools you need to manipulate your 
projects. The desktop displays icons that represent items on your computer, such as apps, 
�les, and folders. A computer �le is a collection of related information. Typical types of 
�les include text documents, spreadsheets, photos, and songs. A folder is a container that 
helps you organize the contents of your computer. 

Windows gets its name from the rectangular areas called windows that appear on 
your screen as you work, such as those shown in Figure 1-1. 

◗ 3. If necessary, click your user name, type your password, and then press the If necessary, click your user name, type your password, and then press the If necessary
Enter key.

The Windows 10 desktop appears, as shown in the Session 1.1 Visual Overview. 
Your screen might look different.

Trouble? If your user name does not appear on the Welcome screen, try 
pressing the Ctrl+Alt+Del keys to enter your name. If necessary, ask your 
instructor or technical support person for further assistance. 

Trouble? If a blank screen or an animated design replaces the desktop, 
your computer might be set to use a screen saver, a program that causes a 
display to go blank or to show an animated design after a specified amount 
of idle time. Press any key or move your mouse to restore the desktop. 

Trouble? If your computer is using a screen resolution other than 1366 � 768, 
the figures shown in this book might not match exactly what you see in Windows 
10 as you work through the steps. Take the screen resolution difference into 
account as you compare your screen with the figures.

Figure 1-1 TwTwT o windows open on the desktop

overlapping windows

You can open two types of windows in Windows 10: those for Windows apps (also 
called universal apps), such as the Weather app, and those for traditional desktop 
applications, such as File Explorer, a tool you use to navigate, view, and work with the 
contents and resources on your computer. You’ll explore both types of windows later in 
the module.
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Touring the Desktop
The �rst time you start a computer after installing Windows 10, the computer uses 
default settings, those preset by the operating system. The default desktop you see after 
you �rst install Windows 10, for example, displays a large background image. However, 
Microsoft designed Windows 10 so that you can easily change the appearance of the 
desktop. You can, for example, change pictures or add color to the desktop.

Interacting with the Desktop
If you are using a laptop or desktop computer, you use a pointing device to interact with 
the objects on the screen. Pointing devices come in many shapes and sizes. The most 
common one is called a mouse, so this book uses that term. If you are using a different
pointing device, such as a trackball or touchpad, substitute that device whenever you 
see the term mouse. Some pointing devices are designed to ensure that your hand won’t 
suffer fatigue while using them. Most mice work wirelessly and provide access to your 
computer without being plugged into it. Others are attached directly to your computer 
by a cable.

You use a pointing device to move the pointer over locations and objects on the 
screen, or to point to them. The pointer is an on-screen object, often shaped like an 
arrow as shown in the Session 1.1 Visual Overview, though it changes shape depending
on its location on the screen and the tasks you are performing. As you move the mouse 
on a surface, such as a table top, the pointer on the screen moves in a corresponding
direction.

When you point to certain objects, such as the objects on the taskbar, a ScreenTip 
appears near the object. A ScreenTip is on-screen text that tells you the purpose or 
function of the object to which you are pointing.

Ashley suggests that during your class, you introduce For Pet’s Sake volunteers to the 
desktop by viewing ScreenTips for a couple of desktop objects. 

To view ScreenTips:
◗ 1. Point to the File Explorer icon  on the taskbar. A ScreenTip identifying the  on the taskbar. A ScreenTip identifying the 

icon appears near the icon, as shown in Figure 1-2.

Figure 1-2 Viewing a ScreenTip

pointerScreenTip

Trouble? If you don’t see the ScreenTip, make sure you keep the pointer still 
for a few seconds. 

Clicking refers to pressing a mouse button and immediately releasing it. Clicking 
sends a signal to your computer that you want to perform an action with the object 
you click. In Windows 10, you perform most actions with the left mouse button. If you 
are told to click an object, position the pointer on that object and click the left mouse 
button, unless instructed otherwise.
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Selecting and Opening Objects
You need to select an item, or object, before you can work with it. To select an object 
in Windows 10, you point to or click that object. Windows 10 indicates an object is 
selected by highlighting it, typically by changing the object’s color or displaying a box 
around it. For example, when you point to the Start button, it changes color. The change 
shows it is the active object. You can interact with active objects by clicking them, for 
example. When you click the Start button, the Start menu opens. A menu is a group or 
list of commands, and a menu command is text that you can click to perform tasks. 

The Start menu provides access to apps, �les, settings, and power options. Ashley 
suggests you click the Start button to open the Start menu.

If you are using a device 
with a touchscreen, a 
check box appears near 
an on-screen object when 
you point to the object. 
A checkmark appears in 
the box when you select 
the object.

To open the Start menu:
◗ 1. Click the Start button  on the taskbar. The Start menu opens, as shown in  on the taskbar. The Start menu opens, as shown in 

Figure 1-3; your Start menu might show different commands.

Figure 1-3 Start menu

user icon

live tile

tile

apps used 
frequently

menu 
commands

◗ 2. Click the Start button  on the taskbar to close the Start menu. on the taskbar to close the Start menu.

Besides menu commands, the Start menu includes colored rectangles called tiles, 
which represent apps. Some tiles display icons, such as the Calendar tile. Other tiles 
display information that previews the contents of the app, such as the Sports tile, which 
displays photos and headlines for current sports stories. A tile that displays updated 
content is called a live tile. Tiles such as the Weather tile become live tiles after you 
open their apps for the �rst time. 

If clicking an object doesn’t open its app, you probably need to double-click it. 
Double-clicking means clicking the left mouse button twice in quick succession. 
For example, you can double-click the Recycle Bin icon to open the Recycle Bin 
and see its contents. The Recycle Bin holds deleted items until you remove them 
permanently.
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Ashley suggests that you have volunteers practice double-clicking by opening the 
Recycle Bin. 

To view the contents of the Recycle Bin:
◗ 1. Point to the Recycle Bin icon, and then click the left mouse button twice 

quickly to double-click the icon. The Recycle Bin window opens, as shown in 
Figure 1-4.

Trouble? If the Recycle Bin window does not open and you see only the 
Recycle Bin name highlighted below the icon, you double-clicked too slowly. 
Double-click the icon again more quickly. 

Now you can close the Recycle Bin window.

◗ 2. Click the Close button  in the upper-right corner of the Recycle Bin 
window.

Figure 1-4 Contents of the Recycle Bin

Close button

this Recycle Bin is 
empty; yours might 
contain files

You’ll learn more about opening and closing windows later in this session.

Displaying Shortcut Menus
Your mouse most likely has more than one button. In addition to the left button, the 
mouse has a right button that you can use to perform certain actions in Windows 10. 
However, the term clicking refers to the left button; clicking an object with the right clicking refers to the left button; clicking an object with the right clicking
button is called right-clicking. (If your mouse has only one button, you right-click by 
pressing the right side of the button.)
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In Windows 10, right-clicking usually selects an object and opens its shortcut menu, 
which lists actions you can take with that object. You can right-click practically any 
object—a tile on the Start menu, a desktop icon, the taskbar, and even the desktop itself—
to view commands associated with that object. Ashley suggests that when you’re not 
sure what to do with an object in Windows 10, you should right-click it and examine its 
shortcut menu. Now you can right-click the Recycle Bin icon to open its shortcut menu.

Now that you’ve explored the desktop, you can return to the Start menu and use it to 
start applications. 

Exploring the Start Menu
The Start menu is the central point for accessing apps, documents, and other resources 
on your computer. The Start menu is organized into two panes, which are separate 
areas of a menu or window. See Figure 1-6.

To right-click an object on the desktop:
◗ 1. Point to the Recycle Bin icon on your desktop, and then right-click the icon 

to open its shortcut menu. This menu offers a list of actions you can take with 
the Recycle Bin icon. See Figure 1-5.

Trouble? If the shortcut menu does not open and you are using a trackball 
or a mouse with a wheel, make sure you click the button on the far right, not 
the one in the middle. 

◗ 2. Click Open on the shortcut menu to open the Recycle Bin window again.

◗ 3. Click the Close button  in the upper-right corner of the Recycle Bin 
window.

Figure 1-5 Recycle Bin shortcut menu

Recycle Bin icon

shortcut menu
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For easy access, the left pane lists the apps you use most often in the Most used 
list. If you have recently added apps, the left pane also lists those apps in the Recently 
added list. When you �rst install Windows 10, the Most used list contains a few apps 
already installed on your computer. After you use an app, Windows 10 adds it to this 
list so you can �nd it quickly the next time you want to use it. The Most used list can 
contain only a certain number of apps—after that, the apps you have not opened 
recently are replaced by the apps you used last.

Near the bottom of the left pane are commands for the following important tools:

•	File Explorer: Navigate, view, and work with the contents and resources on your 
computer.

•	Settings: Select and change system settings.
•	Power: Control the power to the computer by shutting it down, for example.
•	All apps: Select from an alphabetic list of all the apps on the computer.

Use the Search the web and Windows box to access Cortana, an electronic personal 
assistant that can search the web, �nd �les, keep track of information, and respond 
to your questions. You can activate Cortana by typing text or talking. For example, 
you can ask Cortana to tell a joke, remind you about an appointment, or �nd a �le. 
See Figure 1-7.

Figure 1-6 TwTwT o panes of the Start menu

right pane

Search the web 
and Windows box

apps you use 
most often

recently installed 
apps, if any 
appear here

commands for 
important tools

left pane
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From the right pane of the Start menu, you can select tiles for Windows apps, or 
universal apps, a type of app that can run on many devices, including laptops, tablets,
and mobile phones. You purchase, download, and install Windows apps from the 
Windows Store, an online resource for games, music, video, and other types of apps, 
including social and productivity apps. In contrast, many apps in the left pane of the 
Start menu are desktop apps, which run only on personal computers (PCs) such as 
laptops and desktop computers.

Now that you’ve explored the Start menu, you’re ready to use it to start an app.

IN
SI
G
H
T

Cortana

Cortana comes from the Halo series of games where she is a smart and powerful 
character that provides information and helps the master chief complete missions. In 
Windows 10, Cortana is not a character, but a personalized assistant. The Notebook 
is where Cortana keeps track of what you like, such as your interests and favorite 
places, and what you want it to do, such as display reminders or information that might 
interest you. Settings in the People and Maps apps also affect Cortana. For example, 
if you identify a contact as a friend, Cortana can remind you to call that person. If you 
identify locations on the map as your home and workplace, Cortana can estimate the 
time of your commute. As you work, Cortana can take note of your preferences and 
what you’re doing when you ask for information to give personalized answers and 
recommendations. Because you control the type of information you share with Cortana, 
the interactions are on your terms and are personalized to your bene�t.

Figure 1-7 Cortana electronic personal assistant

click if you don’t want 
Cortana to track your 
preferences

click to start 
working with 
Cortana
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Starting an App

•	Click the Start button on the taskbar.
•	Click the tile or command for the app you want to start.
•	 If the app you want does not appear on the Start menu, click All apps, and then click 

the app you want to start.

or

•	 In the Search the web and Windows box, type the name of the app until the app 
appears in the search results on the Start menu; or click the Start button, and then type 
the name of the app until the app appears in the search results on the Start menu. 

•	Click the app in the search results.

Starting Apps
Computers can run two types of software: system software and apps. System software
is the software that runs a computer, including the operating system. As you know, an 
app is the software you use to perform tasks, such as writing a screenplay or viewing a 
webpage. In general, a computer runs system software to perform computer tasks, and 
you run apps to carry out your work or personal tasks. 

Ashley suggests that you demonstrate how to start the Calendar app, a Windows app 
that displays a full-screen calendar where you can schedule appointments and other events.

To start the Calendar app:
◗ 1. Click the Start button  on the taskbar to display the Start menu. on the taskbar to display the Start menu.

◗ 2. Click the Calendar tile to start the Calendar app. If this is the first time you 
are starting the Calendar app, click the Get started button to set up the 
calendar. See Figure 1-8.

Trouble? If a screen appears asking you to let Mail and Calendar access your 
location, click the No button. 
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Now that you have started one app, you can start another app and run two at the 
same time.

Running Multiple Apps
One of the most useful features of Windows 10 is its ability to run multiple programs at 
the same time. This feature, known as multitasking, allows you to work on more than 
one task at a time and to switch quickly between projects. 

To demonstrate multitasking and switching between apps, Ashley suggests that you 
start Paint, a desktop app you use to draw, color, and edit digital pictures. Paint appears 
on the Start menu by default.

Figure 1-8 Calendar app

click the Collapse 
button to collapse 
the left pane

the appearance 
of your Calendar 
might differ

To run Calendar and Paint at the same time:
◗ 1. Click the Start button  on the taskbar to display the Start menu. 

◗ 2. In the left pane, click Paint to start the app. Now two apps are running at the 
same time. 

Trouble? If Paint does not appear in the left pane of the Start menu, click All 
apps, scroll the list of apps, click Windows Accessories, and then click Paint. 

◗ 3. If the Paint window fills the entire screen, click the Restore Down button in 
the upper-right corner of the Paint window to reduce the size of the window. 
See Figure 1-9.
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When you start an app, it is said to be open or running. A taskbar button appears on 
the taskbar for each open app. One taskbar button is highlighted with a background 
lighter than the other taskbar buttons. This button is for the active window, the window 
you are currently working with—Windows 10 applies your next keystroke or command 
to the active window. Paint is the active window because it is the one you are currently 
using. If two or more windows overlap, the active window appears in front of the other 
windows. Even if the Paint window completely covered the Calendar window, you 
could still access the Calendar app by using its taskbar button. The taskbar organizes all 
the open windows so you can quickly make one active by clicking its taskbar button.

Switching Between Applications
Because only one app is active at a time, you need to switch between apps if you want 
to work in one or the other. The easiest way to switch between running apps is to use 
the taskbar buttons.

Another way to use the taskbar to switch between open apps is to use the Task View 
button. By default, the Task View button is the �rst button to the right of the Search the 
web and Windows box. Click the Task View button to display thumbnails of all running 
apps. (A thumbnail is a miniature version of a larger image, such as a window.) 
See Figure 1-10.

You can also click an 
inactive window to make 
it the active window.

Figure 1-9 TwTwT o apps open

Paint button on the 
taskbar is highlighted, 
indicating that Paint is 
the active window

Calendar button on 
the taskbar is not 
highlighted, indicating 
that Calendar is not 
the active window

Calendar window; 
yours might be hidden 
by the Paint window

Paint window appears 
in front of the 
Calendar window

To switch between Calendar and Paint:
◗ 1. Click the Calendar button  on the taskbar. The Calendar window moves to 

the front, and the Calendar taskbar button appears highlighted, indicating 
that Calendar is the active window.

◗ 2. Click the Paint button  on the taskbar to switch to the Paint app. The Paint 
window is again the active window.
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You can switch to one of the running apps by clicking its thumbnail or close it by 
clicking its Close button. Clicking a thumbnail displays its full window as the active 
window. To close the Task view, click the Task View button again. 

Besides switching apps, you can click the New desktop button in Task view to add 
a new desktop to the interface, called a virtual desktop. For example, you might use 
the default desktop for school or work projects, and another desktop for entertainment, 
such as a music player and games.

Another way to switch apps is to bypass the taskbar altogether and use keyboard 
shortcuts to switch from one open window to another. A keyboard shortcut is a key or 
combination of keys that performs a command. Use the Alt+Tab keyboard shortcut to 
switch between running apps. To do so, you hold down the Alt key and then press the 
Tab key to display thumbnails of all running apps, press the Tab key again to select a 
thumbnail, and then release the Alt key to make that app active. Pressing the Alt+Tab 
keys displays thumbnails similar to Task view. However, when you release the keys, the 
thumbnails no longer appear. In Task view, the thumbnails remain on the screen until 
you select one. 

Manipulating Windows
After you open a window, you can manipulate it to display as much or as little information
as you need. In most windows, three buttons appear on the right side of the title bar. See 
Figure 1-11. The �rst button is the Minimize button, which hides a window so that only its 
button is visible on the taskbar. Depending on the status of the window, the middle button
either maximizes the window or restores it to a prede�ned size. The last button is the 
Close button, which closes the window. 

Figure 1-10 Task vieTask vieT w

Task View 
button

thumbnail of the 
Calendar app 

click to add 
a virtual 
desktop

thumbnail 
of the Paint 
app

Figure 1-11 Window buttons

Minimize button

Maximize button
Close button

Paint and Calendar are open on the desktop, so Ashley encourages you to show 
volunteers how to use their window controls. Start with the Minimize button, which 
you use when you want to temporarily hide a window but keep the app running.
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To minimize the Paint and Calendar windows:
◗ 1. Click the Minimize button  on the Paint title bar. The Paint window shrinks 

so that only the Paint taskbar button is visible.

Trouble? If the Paint window closed, you accidentally clicked the Close 
button . Use the Start menu to start Paint again, and then repeat  
Step 1. If you accidentally clicked the Maximize button 

. Use the Start menu to start Paint again, and then repeat  
 or the 

Restore Down button , repeat Step 1. 

◗ 2. Click the Minimize button  on the Calendar title bar. The Calendar 
window is minimized.

To redisplay the Paint window:
◗ 1. Click the Paint button  on the taskbar to redisplay the Paint window. 

The taskbar button provides another way to switch between a window’s 
minimized and open states.

◗ 2. Click the Paint button  on the taskbar again to minimize the window.

◗ 3. Click the Paint button  once more to redisplay the window.

To maximize the Paint window:
◗ 1. Click the Maximize button  on the Paint title bar.

You can redisplay a minimized window by clicking the window’s taskbar button. 
When you redisplay a window, it becomes the active window.

The Maximize button enlarges a window so that it �lls the entire screen. Ashley 
recommends that you work with maximized windows when you want to concentrate 
on the work you are performing in a single app.

The Restore Down button reduces the window so that it is smaller than the entire 
computer screen. This feature is useful if you want to see more than one window at a 
time. Also, because the window is smaller, you can move it to another location on the 
screen or change its dimensions.

You can also double-click 
a window’s title bar to 
maximize the window. 
Double-click the title 
bar again to restore the 
window to its previous size.

You can use the mouse to move a window to a new position on the desktop. When you 
click an object and then press and hold down the mouse button while moving the mouse, 
you are dragging the object. You can move objects on the screen by dragging them to a dragging the object. You can move objects on the screen by dragging them to a dragging
new location. If you want to move a window, you drag the window by its title bar. 

To restore a window:
◗ 1. Click the Restore Down button  on the Paint title bar. After a window is  on the Paint title bar. After a window is 

restored, the Restore Down button  changes to the Maximize button  changes to the Maximize button .
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You can also use the mouse to change the size of a window. When you point to 
an edge or a corner of a window, the pointer changes to the resize pointer, which is a 
double-headed arrow. You can use the resize pointer to drag an edge or a corner of the 
window and change the size of the window.

You can also use the resize pointer to drag any of the other three corners of the 
window to change its size. To change a window’s size in any one direction only, drag 
the left, right, top, or bottom window borders left, right, up, or down.

To drag the restored Paint window to a new location:
◗ 1. Position the pointer on the Paint title bar.Position the pointer on the Paint title bar.Position the pointer on the Paint title bar

◗ 2. Press and hold down the left mouse button, and then move the mouse up or 
down a little to drag the window. The window moves as you move the mouse.

◗ 3. Position the window anywhere on the desktop, and then release the left 
mouse button. The Paint window stays in the new location.

◗ 4. Drag the Paint window near the upper-left corner of the desktop.Drag the Paint window near the upper-left corner of the desktop.Drag the Paint window near the upper

To change the size of the Paint window:
◗ 1. Position the pointer over the lower-right corner of the Paint window. Position the pointer over the lower-right corner of the Paint window. Position the pointer over the lower

The pointer changes to . See Figure 1-12.

◗ 2. Press and hold down the mouse button, and then drag the corner down and 
to the right.

◗ 3. Release the mouse button. Now the window is larger.

◗ 4. Practice using the resize pointer to make the Paint window larger or smaller.

Figure 1-12 Preparing to resize a window

resize pointer
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Using App Tools
When you run an app in Windows 10, it appears in a window that contains controls, 
graphical or textual objects used for manipulating a window and for using an app. All 
apps organize controls in dialog boxes. A desktop application also uses a ribbon to 
provide controls.

Ashley mentions that Windows 10 comes with a basic word-processing app called 
WordPad. You use WordPad to create and format basic documents. The WordPad app 
displays the controls you are likely to see in most windows, including the ribbon, 
which might be unfamiliar to For Pet’s Sake volunteers. Ashley suggests that you start 
WordPad and identify its window controls during your �rst training session. You have 
already started apps using the left and right panes on the Start menu. To start WordPad, 
you can use the Search the web and Windows box.

As you enter text in the Search the web and Windows box, the Start menu displays 
search results, including the installed apps, folders, documents, and settings whose 
names include the text you typed. The search results might also include web search 
text and Windows Store apps. Two buttons appear at the bottom of the search results: 
the My stuff button and the Web button. Click the My stuff button to restrict the search 
to locations on your computer, OneDrive, or network. Click the Web button to start a 
browser and search the web using the text you entered as the search text.

To start WordPad:
◗ 1. Click the Start button  on the taskbar to display the Start menu. The  on the taskbar to display the Start menu. The 

insertion point appears in the Search the web and Windows box so you can 
search for an app or other information.

◗ 2. Type Type T WordPad to search for the WordPad app and display the results in the 
Start menu. 

◗ 3. Click WordPad on the results list to start the app. 

◗ 4. Click the Maximize button  on the WordPad title bar to maximize the 
window.

Using the Ribbon
Many desktop apps use a ribbon to consolidate features and commands. The ribbon 
is located at the top of a desktop app window, immediately below the title bar, and 
is organized into tabs. Each tab contains commands that perform a variety of related 
tasks. For example, the Home tab has commands for tasks you perform frequently, such 
as changing the appearance of a document. You use the commands on the View tab to 
change your view of the WordPad window.

To select a command and perform an action, you use a button or other type of 
control on the ribbon. Controls for related actions are organized on a tab in groups. 
For example, to enter bold text in a WordPad document, you click the Bold button in the 
Font group on the Home tab. If a button displays only an icon and not the button name, 
you can point to the button to display a ScreenTip and identify the name or purpose of 
the button. Figure 1-13 shows examples of the types of controls on the ribbon.

By default, the ribbon 
displays the Home tab 
when you start WordPad. 
To display the contents of 
the View tab, you click the 
View tab on the ribbon.
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Figure 1-13 Examples of ribbon controls

toggle button two-part button 
with arrow

related controls 
organized into a group

box button with arrow

Figure 1-14 describes the types of ribbon controls.

Figure 1-14 Types of contrTypes of contrT ols on the ribbon

Control How to Use Example
Button with arrow Click the button to display a menu of related 

commands.

Box Click the box and type an entry, or click the arrow 
button to select an item from the list.

Toggle button Click the button to turn on or apply a setting, and 
then click the button again to turn off the setting. 
When a toggle button is turned on, it is highlighted.

Two-part button 
with arrow

If an arrow is displayed on a separate part of the 
button, click the arrow to display a menu of commands. 
Click the button itself to apply the current selection.

Using Dialog Boxes
When you click some buttons on the ribbon, you open a dialog box, a special kind 
of window in which you enter or choose settings for how you want to perform a task. 
For example, you use the Print dialog box to enter or select settings for printing a 
document.

You open dialog boxes by selecting a command on a ribbon tab. For example, the 
File tab lists commands such as Open, Save, and Print in its left pane. If you point to the 
Print command, a list of three printing options appears in the right pane, including Print, 
Quick print, and Print preview. Choose Print to open the Print dialog box, where you 
can change settings such as the number of copies to print. If you want to print the open 
document without changing any settings, choose Quick print. Choose Print preview to 
display the document as it will appear when you print it. If you click the Print command 
in the left pane without displaying the three printing options, the Print dialog box opens.

Dialog box controls include command buttons, tabs, option buttons, check boxes, 
and boxes to collect information about how you want to perform a task. Ashley says a 
good way to learn how dialog box controls work is to open a typical WordPad dialog 
box, such as the Print dialog box. 
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